


Bill Drafting with Microsoft Word

SOURCES OF MATERIALS FOR DRAFTING
Several important materials are available at the webpage for the Office of Legislative Services:
 http://www.legis.state.wv.us/Joint/legis_services.cfm

On this webpage you will find links to documents that you may download to get you started. The first of these is the Bill Drafting Manual. It is used by all attorneys at the Legislature to prepare bills and resolutions. The Manual explains the Legislature’s conventions used in wording, formatting, and legal writing. It contains many examples to illustrate the most common situations relevant to legislative bills. 
Another useful file is the basic bill template. This is what our drafters use to build a bill for introduction. This template also contains the style sheet information for the proper formatting of various parts of a bill.

Using the Flash Drive
The flash drive provided by Legislative Services contains a series of files, in Word format, known as the Drafter’s Code. This contains the latest revisions to the Code plus some recommended amendments to revise gender references and remove certain deprecated language. All files are in a folder on the disc named “WV Code” and it is organized into subfolders for each chapter of the Code, e.g. “WVC 11” for Chapter 11.  Within each chapter folder your will find all of the sections for that chapter as well as files for the chapter and article headings. 
The root directory of the flash drive also contains a copy of the basic bill template and the Bill Drafting Manual.
CREATING A BILL
To begin creating a bill, open up the bill template in Word. You should see a page that looks like this:
[image: ]
Since this is just a template, you should immediately save this as a separate document under a name that you wish to use for your bill draft. You can then begin to add text to your bill.
As you are probably aware, the new bill format uses a cover page for the information that previously appeared in the bill heading on the first page of bills. There are several fields for information on this page that may be completed later by legislative staff and you do not have to fill in or change many of these fields.  In most cases, the only text that you may want to change is the name of the chamber and the sponsor information.
When you click on the text that says, “Enter Sponsors Here,” a thin outline appears around this text and you can simply overwrite this text with the name of the bill sponsor.  For example, “Delegates Allwork and Often” or “Senator Howse.”
The second page is for the real substance of the bill. There are two areas (fields) that hold the place of the Bill Title and the body of the bill, although these are not indicated by boxes or shaded areas.
[image: ]
The line numbers are already set up in the document and the first line number one is for the section of the bill known as the Bill Title. The second line numbered 1 is the place where a drafter writes the operative portions of the bill.[footnoteRef:1] Most drafters prefer to work on the actual text of the legislative code first. Later you may return and prepare the Title to reference the Code sections that are to be affected by the legislation. You may begin writing from scratch, but often you’ll probably want to pull in text that already appears in some other form.  Typically, this involves inserting code sections from the Drafter’s Code or pasting text from an old bill or a draft provided by someone else. We’ll explain both of these methods below. [1:  PLEASE NOTE that with bills for the 2018 Regular Session, we no longer include the portion, commonly called the ‘enacting section,’ which listed the individual sections affected and whether these were repealed, amended or added. Since this is redundant of the language in the Title, bills will no longer contain this element.] 


INSERT CODE SECTIONS AND HEADERS
There are two ways to insert sections of the Code into your draft bill.  One method is to open one of the section files and then copy the text from that file into the bill shell.  The other method is to insert the text from the section files from within the bill shell once you have begun your draft.

In 2007 Microsoft did away with the File, Import command that allowed a person to pick other documents and insert them into a working document.  If you search for this in Word’s Help files you won’t be able to find it. Instead, this procedure is called Insert, Object, Text from File. To begin the process, make sure your cursor is placed at the spot in your document where you want to insert the Code section or header.

Next, go to the INSERT tab on the Word ribbon. There is a group of icons labeled “Text” that look something like this:
Word 2007	[image: ]  

 Word 2013   [image: ]

Look for the small button labeled “Object.”  When you click on this, there are two options that will appear.  

[image: ]

Select “Text from File…” to open a file selection dialog box and then navigate to where the Code files are kept (such as the flash drive.)

[image: ]


Since there are over 29,000 Code files you may not want to scroll all the way through the list to find the one section that you seek. Word can help you narrow down the list if you type the beginning of the filename:

[image: ]
When you insert several Code sections, you probably will see some hiccups in the line numbering when the text shifts from one section to the next.
[image: ]

If you wish to update the line numbering yourself, please see the “LINE NUMBERING” section below for an explanation of how to restart line numbers with each section. On the other hand, if you are merely preparing a draft for review and don’t need to have the line numbering in final form, you may ignore these numbers and this can be fixed when the bill is submitted to Legislative Services.


Inserting Chapter and Article Headings
To add a chapter or article heading, look for the filenames with trailing dashes.  Chapter heading files will only have the chapter number and a dash. (Example: WVC 29 - .docx) Article heading files have the chapter number, a dash, the article number and another dash in the filename. Example: WVC 61 – 4 - .docx will give you just the article heading, like so:

ARTICLE 4. FORGERY AND CRIMES AGAINST THE CURRENCY.




USING TEXT FROM OTHER SOURCES
Frequently you will have a document, such as an old bill, that you want to use to start out your draft or reformat into a new bill. In this case there will be portions of the document that you want to copy and paste into your draft. 

Text Formatting and the Paste Options icons 
When you paste text into your document, you have several options as to how Word will handle formatting information that is contained in the copied material.  These options are typically displayed with these icons: [image: ] The first icon will paste the text exactly how it was formatted in the source from which you copied it. The second icon attempts to merge the formatting from the source with the formatting in your bill.  The third icon pastes the plain text into your document without any formatting from the source.  We don’t recommend the middle option because it can lead to unpredictable results. Most users will only want to use the Keep Source Formatting option or the Keep Text Only options. The option that you choose will depend on your source and what information you are trying to preserve.
If you are using source material, such as an old bill, that contains strike-throughs and underscores and you wish to keep this mark-up, you will need to use the Keep Source Formatting option.  This is the only option that preserves strike-throughs. Note that this option will also keep other formatting such as indentations, tabs and fonts, which you will then have to correct using the Styles tools described in the next section. In many cases, you may have to remove some extra spaces and tabs manually. Another issue with this option is that special symbols, including section symbols may not translate properly. 
If you are copying from a PDF document that has line numbers or if you do not need to worry about strike-throughs, then the preferred paste option is to Keep Text Only. When you paste text into your document with this option, the text will be formatted to match that portion of the document in which you are working. In most cases, you will not need to modify the formatting of the text in any way.

USING STYLES TO FORMAT TEXT
Because the format of legislative bills follows a consistent and predictable pattern, Word makes it simple to apply formatting to each part of a bill.  All the necessary formats for these parts have been set up as text styles that are available from the ribbon under the HOME tab. When you have the HOME tab selected, you will see a group of styles that will look something like this:
[image: ]
The number of styles that you can see will depend on the size of your screen and the size of the Word window on that screen.  To see all of the bill formatting styles, just click on the expansion button on the right edge of this group.  It is the small button with a line and a tiny, inverted triangle.
[image: ]
When you click on this button, a larger window appears showing all style options.
[image: ]
To format a block of text, simply highlight the text in your draft and then click on the corresponding style in this window. Thus, if you create a new article header or insert an article header from a differently formatted source, you would highlight all of the text in your header, 
[image: ]
and then click on the Article Header style.  This action formats the line in one, simple operation.
[image: ]
If you have a portion highlighted, you can preview how the text will look in your document by hovering the mouse cursor over the style you wish to preview.  This temporarily reformats that highlight portion of your bill until you click to make the format permanent or until you hover over another style to preview that one.

OUTLINE LEVELS
Standard West Virginia Code citation uses the format Chapter-Article-Section with alphanumeric identifiers for each of these elements: §29A-3-1 refers to Chapter 29A, Article 3, Section 1. Each of these division levels takes a different style to format the title line or heading of element. In some situations, typically occurring with uniform or model law drafts, there is an addition outline level, called the Part that appears between the Article and Section. When this is used, there is a separate style to format the Part name in a bill:
[image: ]

For further breakdown of Code sections, please follow this outline form for the levels of division: 
	§ Section.
	     (a) subsection – lower case letters
		(1) subdivision – Arabic numbers
			(A) paragraph – upper case letters
				(i) subparagraph – lower case Roman numerals
				(ii)
					(I) clause – upper case Roman numerals
					(II)
By default, Microsoft Word attempts to create an outline or numbered list if you begin a paragraph with a numeral or an enclosed letter.  This can be very frustrating as it attempts to format the following paragraphs according to its default list format.  When working with bills, it is recommended that you turn off the automated list function.  The settings for this are in the Options under the File tab.

Go to the File tab and select ‘Options’ at the bottom of the list in the left margin. When the Options dialog box appears, select ‘Proofing.’  You will then see a button for ‘AutoCorrect Options.’
[image: ]
Click on this button and then look for the tab for ‘AutoFormat.’  In the first section under this tab, un-check the boxes for ‘Automated bulleted lists’, for ‘List styles’, and for "Straight quotes" with "smart quotes".
[image: ]
In addition, you will need to look at some settings under the “AutoFormat As You Type” tab in this same window.
        [image: ]
In the section labeled “Apply as you type” make sure that “Automatic bulleted lists” and Automated numbered lists” are not checked. It will also be useful to uncheck the boxes for "Straight quotes" with "smart quotes", “Fractions (1/2) with fraction character”, and “Ordinals (1st) with superscript” because these conflict with the standard bill format.


USING HEADING SHORTCUTS

If you use the chapter, article and section headings as shown in this guide, MS Word can use those styles to give you a simple outline of the parts of your bill and help you navigate between them. To view this outline, go to the Home tab on the document ribbon and look for the Find button on the far, right end.
  	    [image: ]
Click “Find” and a Navigation frame will open on the left side of the program window. Make sure there is nothing entered in the search box (the white rectangle with the magnifier) and click on “Headings.” This will show you the outline and you can navigate to each section by clicking on its heading in this outline.
[image: ]
LINE NUMBERING
In the new bill format, line numbering restarts with each section of the bill rather than by page. Only the following portions of a bill have line numbering: the Bill Title and the text of each section of the Code, but not the division headings. If you are working on rough drafts of your bill and have no need to refer to the line numbers in discussion of the bill, then you do not need to deal with where the line numbers start or restart.  You may submit a draft bill to Central Bill Drafting without bothering with the line numbering and this will be cleaned up before introduction of the bill.
If, on the other hand, you wish to circulate your draft and you want people to refer to the same line numbers, here is how to force the restart of line numbers for each section in your bill:
	1. Move to the first Code section in the bill and place your cursor at the very beginning of the first line in the body of the Code section.
	2. Now go up to the ribbon and select the ‘PAGE LAYOUT’ tab.
	3. When this tab is opened, you will see some buttons for Page Setup, including three stacked icons for Breaks, Line Numbers, and Hyphenation.  Select ‘Breaks,’ NOT ‘Line Numbers.’
[image: ]
	4. When you click on ‘Breaks,’ a drop-down menu will appear.  Select ‘Continuous,’ the fifth item down in this menu.
[image: ]
	The line numbers in your first section will be automatically adjusted to begin with the first line of text in the body of the section.
	5. You will need to repeat this process for each section of Code in your bill.

STRIKE-THROUGHS, UNDERSCORES AND SYMBOLS
Underscores -There are several ways to underscore a section of text in Microsoft Word, and the most convenient is to highlight the text you want to underscore and press Ctrl+U.  This will add underscoring to all of the text in the highlighted area.
Strike-throughs -There is currently just one, main way to mark text with strike-throughs.  To do this, you must have the HOME tab selected on the ribbon. In the group of Font controls, there are several icons to alter the format of the text on your screen.  Highlight the portion of text that you want to strike-out and then click on the icon showing a small “abc” with strikethroughs:
[image: ]
Symbols –This guide cannot provide detailed instructions about adding special symbols, except for one critical symbol: the section symbol §. There is a simple keystroke combination that will add this symbol when you are typing.  Hold down the Alt key and then, using the numbers on the numeric keypad, type 21.  When you release the Alt key, the symbol will appear.  You may only use the numeric keypad for this; it won’t work if you use the numbers at the top of your keyboard.

FINISHING YOUR DRAFT
	The last part of the bill that must be included is the bill’s purpose.  As you are aware, the purpose is set out in a Note at the end of the bill. The basic bill shell already has some text in place for the Note as follows:
[image: ]
Simply click on the text “Enter Purpose” to insert your wording about the purpose of the bill.  Now both chambers of the Legislature use one, standard method for indicating new or deleted text, and there is no longer a need to have different boilerplates about strike-throughs and underscores.  Therefore, this standard text has been added to the bill shell for you and does not need to be modified.


	- 2 -	December 2022
image2.JPG
ABILL

Be it enacted by the Legislature of West Virginia:

NOTE: The purpose of this billis to

Strike-throughs indicate language that would be stricken from a heading or the present law
and underscoring indicates new language that would be added
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